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1. WELCOME 

Welcome to the Bio Image Analysis workshop.  

This workshop provides case studies for representative High Content Analysis problems. These 
include neurite analysis of single and mixed cell populations, co-culture analysis to 
simultaneously analyse multiple cell-type populations, subcellular analysis to measure protein 
translocation and assess co-localisation of two different proteins, and cell scoring to count the 
number of cells that express two different proteins to a level above user defined values. 

HCA-Vision will be used as the tool to solve these problems. It uses automated image analysis 
to rapidly produce measures of functional properties of cells. 

2. HOW TO LOAD IMAGES & SWITCH TO A DIFFERENT 
MODULE 

2.1 Launch HCA-Vision 

First of all, launch HCA-Vision by double clicking HCA-Vision icon on the desktop of your 
computer, or from Start menu, click Start>All Programs>HCA-Vision>HCA-Vision. 

2.2 Load an Image 

After HCA-Vision is launched, you can load an image into HCA-Vision in one of the following 
two ways: 

1) Using left hand side File Pane shown in the following figure. Navigate the directory tree to 
locate the image file you want to load, then click the image file name. 

 Or 

2) Using File menu. Click File>Open pull-down menu and select the image file to load. 

By default, the sample image shown in Figure 1 will be automatically loaded. Otherwise, it can 
be located at C:\HCA-Vision\SampleImages\Sample.tif. 
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Figure 1 Layout of HCA-Vision 

2.3 Switch to a Different Module 

There are three modules currently available in HCA-Vision, including Neurite Analysis and 
Subcellular Analysis.  

To switch from one module to another, just click Modules menu, then click the module you 
want to switch to. 

3. NEURITE ANALYSIS 

HCA-Vision's Neurite Outgrowth Module is a powerful tool for the analysis of neurite structure 
in fluorescence images. The software is designed to operate in both an exploratory mode (on 
single or small groups of images) or in batch mode ( large batches of images for screening). The 
wizards provided in this module guide the user through the process of segmentation and 
analysis of neuron bodies and neurite outgrowth. Quantitative measures and statistics that are 
biologically relevant are delivered on both a cell-by-cell and image-by-image basis. 

Some definitions of neurite segments are given in the following figure. 
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Figure 2 Neurite segment definitions 

3.1 Neuron Body Detection 

With HCA-Vision, neurite analysis is divided into three steps, including neuron body detection, 
neurite detection, and neurite analysis. After you load your image, the first thing to do is to tune 
the parameters for these steps by launching the wizard for each step. These wizards can be 
launched from Wizard menu. Click Neuron Body Detection Wizard to bring up the neuron body 
detection wizard. The first page shows there are nine steps for neuron body detection. These 
include: 

3.1.1 Load an Input Image 
 

The window will instruct you to choose an input image. Given you have loaded the image, we 
will assume this step has been performed. Click the Next button. 

3.1.2 Select an Input Image 
 

The Wizard now requires you to select the channel in the image which contains the neuron 
bodies. In our example, the neuron bodies are in the green channel, number 1. This is the default 
value loaded in the software. You can click on the up and down arrows to see the other 
channels. The numbering starts from 0, typically red, and continues to the maximum number of 
channels minus 1 in the image. Ensure that you are using the green channel and click Next. 
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3.1.3 Smoothing (Gaussian Filtering) 
 

You are now required to set the pre-filtering parameter. The default parameter here is 6. Pre-
filtering the image allows you to smooth your image to reduce the effect of noisy image capture. 
Moving the slider to the right increases the parameter. The result of pre-filtering will be shown 
in the Result pane of the software. If you set the slider to 0, no pre-filtering will occur. Return 
the slider to 6 and click Next. 

3.1.4 Background Correction (Morphological Top Hat) 
 

Background correction attempts to flatten the black part of the image. This is controlled by the 
"width" parameter. It should be set so the value is larger than the diameter of the largest neuron 
body. The default value here is 99. Moving the slider to the left makes the software treat the 
dark edges of the cytoplasm like background and flatten them. Return the slider to 99 and click 
Next. 

3.1.5 Suppression of Neurites (Morphological Opening) 
 

Neurite structure now needs to be removed from the image. This is done by setting the "width" 
parameter. The default parameter here is 7. You can see the result in the Result pane has 
removed the neurite outgrowth from the image. Moving the slider to the right removes more 
than just the outgrowth, but parts of neuron body as well. Move the slider to the left and the 
neurite outgrowth will re-emerge. Return the slider to the value 7 and click Next. 

3.1.6 Intensity Thresholding 
 

The image now needs to be separated into foreground ( the neuron bodies) and background 
using a "threshold value". The wizard now presents the user with a slider for the value 
"threshold sensitivity". The default value here is 0.05 (se Figure 3). The resulting labelled image 
is automatically displayed in the Result pane. The cell bodies are now uniquely colour coded. 
Disregarding the "holes" where the nuclei in the red channel occur, we have managed to pick up 
most of the cell bodies. Moving the slider to the left will pick up some of the fainter cell bodies, 
but the trade off is the detected cell bodies for brighter objects may be too big. By increasing 
this parameter, you loose some of the fainter cell bodies, but get more correct results for bright 
objects. Return the slider to 0.05. 

To have a comparison between your result image and the original image, you can click 
Overlay>Enable Flicker>Channel Image (see Figure 4) to have a flashing display in the Result 
pane showing the neuron channel image and the result image overlayed on the neuron channel 
image. By doing so, you can locate which neurons are missing from the result image and change 
the threshold value accordingly. You can also choose the original image or other image 
channels or inverted image channels from the menu shown in Figure 4 to compare the result 
image and the chosen image. You can apply the “Flicker” function on all labelled result images. 
Alternatively, you can apply the “Overlay” function by clicking Image Overlay menu shown in 
Figure 4, then choose a channel image or the original image to be overlaid. 
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Figure 3 Intensity Thresholding wizard page 

 

Figure 4 Menus to turn on “Flicker” feature 
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3.1.7 Nucleus Channel 
 

To further improve the result of the above threshold, we can use nucleus channel information if 
it is available. In our example, a nucleus stain was captured in channel 0. Click the "Show" 
button in the wizard. In the Input pane you will see the nucleus stain and in the Result pane a 
result of thresholding the nucleus stain. If the nucleus stain is contained in a separate image you 
can load it by clicking on the "..." button. We need to threshold the nucleus image in much the 
same way as we did for the cell bodies. By adjusting the slider corresponding to "Nucleus 
Threshold Sensitivity" you can see the effect of setting this value closer to 1 ( only detect bright 
objects) or closer to 0 ( detect all objects, but results are too big and nuclei are merged). Return 
this slider to 0.34. The "Nucleus Area Threshold" is used to reject nuclei whose area falls below 
the threshold. If the “Declump” tick box is ticked, Maximum Nucleus Size can be used to 
specify the maximum nucleus area above which the nucleus will be declumped. However, the 
declumping function also depends on the average size of the nuclei in the image. You may find 
that some nuclei are not de-clumped even if their area is larger than the specified Maximum 
Nucleus Size. For the sample image, return the Maximum Nucleus Size slider to 300, untick the 
Declump box and click Next. 

 

3.1.8 Nucleus Selection 

Further manipulation of neuron body detection can be achieved by discarding nuclei that are too 
dark, or even too bright. The "Intensity Threshold" can be used to discard objects whose 
intensity, in a specified channel, is too low. The " Low Intensity Threshold" and " High 
Intensity Threshold" can be used to reject nuclei whose intensity fall outside a range of 
intensities in a specified channel. Return all the sliders to 0 and click Next for the sample image.  

 

3.1.8 Object Selection 
 

The next section allows you to remove some neuron bodies. You can remove neuron bodies 
touching the border or within a certain distance of the border by adjusting the "Border Width" 
slider. Neuron bodies less than a minimum area can also be removed by adjusting the 
"Minimum Neuron Body Area" slider. Return both sliders to 0 and click Next. 

 

3.1.9 Optional Measurement 
 

If the user is interested in intensity based information from another channel (eg. protein 
translocation studies), you can select the appropriate channel in this dialogue box. You can also 
choose various regions in which to measure intensity. The region choice is dependent on 
whether a nuclear mask was generated in the previous step. You can choose from cytoplasm, 
nucleus and cell membrane. If you don't wish to select any of these options, click "Next". 

 

3.1.10 Save the Parameter Profile 
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We have completed the parameter tuning process for neuron body detection. Now you should 
save these parameters into a profile. Specify the profile name then click “Save” button to do so 
(refer to Figure 5) and then click Finish. If you do not wish to save the parameters, simply click 
Finish. 

 
Figure 5 Save Neuron Body Detection parameter profile 

3.2 Neurite Detection 

The second stage of analysis is detecting the neurite structures. Go to the Wizard pull down 
menu and select "Neurite Detection Wizard". A window will pop up introducing you to the 
wizard facility and outlining the steps involved. The steps are addressed below: 

3.2.1 Load an Input Image 
You will be instructed to open an image file. If you have been following the Tutorial, you will 
already have the file "Sample.tif" open in the Input pane. If you are starting here, open the 
image "Sample.tif" as instructed in the Section 2 of this document. Click Next. 

3.2.2 Select an Input Channel 
You are now required to select the channel which contains the neurite outgrowth. In the current 
example, it is the green channel number 1. You can click on the up and down arrows to see the 
other channels. The numbering starts from 0, typically red, and continues to the maximum 
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number of channels minus 1 in the image. Ensure that you are using the green channel and click 
Next. 

3.2.3 Preprocessing (Gaussian Smoothing) 
You are now required to set the pre-filtering parameter. The default parameter here is 8. Pre-
filtering the image allows you to smooth your image to reduce the effect of noisy image capture. 
Moving the slider to the right increases the parameter. The result of pre-filtering will be shown 
in the Result pane of the software. If you set the slider to 0, no pre-filtering will occur. Return 
the slider to 8 and click Next. 

3.2.4 Linear Feature Detection 
The Wizard now requires you to set 2 parameters, "Linear Window Size" and "Contrast". The 
parameter "Contrast" controls how different the brightness of a neurite can be compared to its 
background. By moving its slider to the left you can pick up more neurite structure. The 
opposite occurs as you move the slider to the right i.e. you start to miss structures. You will 
notice that the linear structures in some instances look broken. This is OK as you get a chance 
to join them, which is described in two paragraphs from here. Return the slider to the value 
1.22. Adjusting the parameter "Linear Window Size" has a much more subtle effect. What it 
controls is the size of the window in which the background and foreground are determined for a 
particular pixel. The default value of 9 should be sufficient for most applications. You may try 
increasing it in images where neurite outgrowth is particularly wide. Click Next. 

Please note, if you notice that some dots are detected instead of a line for a neurite no matter 
how you change the above parameters, please click Back to go back to Gaussian Smoothing 
step, try to increase the Gaussian Smoothing parameter, then click Next to come back to the 
Linear Feature Detection step and try again. 

3.2.5 Remove Small Objects 
Setting the value of "Diameter" for the major diameter of the best fitting ellipse of small objects 
is the next step. The default value of 7 removes all the small noisy objects we picked up in the 
last step while not removing any real neurite structure. Try moving the slider to the right and 
you will notice we remove too much neurite structure. Return the slider to 7 and click Next. 

3.2.6 Gap Closing 
Here we join broken neurite segments by adjusting the parameter "Distance". The default value 
of 9 works well for our example image. If you move the slider to the left you will see how 
setting this value too low will retain the broken appearance of our initial result. Return the slider 
to 9. The "Quality" parameter allows the user to discard links joining broken neurite segments 
that do not satisfy a brightness criteria. The mean brightness of the link must be greater than the 
average of the brightness at the endpoints it connects scaled by the "Quality" percentage. 
Moving the slider to the right will discard more of the links. Return the slider to 6 and click 
Next. 

You now have completed the neurite detection. You can save the parameters you have tuned in 
a parameter profile. This parameter profile can have the same profile name as that used to save 
the Neuron Body Detection parameters or it can be saved with a different name. Click Finish. 



NEURITE ANALYSIS 

       Bio Image Analysis Workshop   13 

3.3 Neurite Analysis 

The final stage of analysis is neurite analysis. Here we associate neurite outgrowth with neuron 
bodies, construct the neurite trees and calculate various measurements described in the Results 
section. Go to the wizard pull down menu and select "Neurite Analysis Wizard". A window will 
pop up introducing you to the wizard facility and outlining the steps involved. Click the Next 
button.  

3.3.1 Load an Input Image 
You will be instructed to open an image file. If you have been following these notes, you will 
already have the file "Sample.tif" open in the Input pane. If you are starting here, open the 
image "Sample.tif" as instructed in the "Open and View an Image" section of the tutorial. It is 
also assumed that you have performed Neuron Body Detection and Neurite Detection, the 
parameters of which will be automatically loaded if you have followed the tutorial. These 
parameters can alternatively be loaded, if you have saved them, as described here. Click the 
Next button. 

3.3.2 Debarb Small Neurite Branches 
You are now required to set the parameter “Length”. Here, any branch in a neurite tree structure 
with length less than this parameter is pruned from the tree. The default value of 15 is usually 
sufficient for most applications. Click Next. 

3.3.3 Thicken Neuron Bodies 
The next step is to set the "Width" parameter. The neuron bodies are thickened to ensure that 
the neurites are touching the neuron bodies. The default value loaded into the program is 0. The 
effect of increasing this value too much is to connect neurite segments to cell bodies that are 
probably not actually related to the cell body. This in turn will inflate the number of primary 
neurites output (see Results section for description). Return the slider to 0 and click Next.  

3.3.4 Remove Small Trees 
The final parameter to set is “Length”. Small, spurious neurite trees can often occur around the 
edges of neuron bodies. Adjusting this parameter allows you to remove trees with length less 
than the value specified. If the value is set to 0, no trees will be removed. Return the slider to 
the default value of 4 and click Next.  

You now have completed the neurite analysis. The results are all shown in the Result pane and 
are discussed in detail in the results section. You can save the parameters you have tuned in a 
parameter profile. This parameter profile can be saved with the same name as the previous steps 
or with a different name. Click Finish. 

3.4 Neurite Analysis Results 

In this section the output of the neurite analysis is discussed. It is assumed you have been 
following the Tutorial up until this point. We refer to the output of the example image processed 
in the tutorial, but it also serves as the main reference point for describing the output. 
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3.4.1 Result Images 

The neurite analysis produces two result images. The first of which is automatically displayed 
in the Result pane of the software or by clicking on the "Result Image" tab at the bottom of the 
right pane. This image is called the neurite parent image. It is colour coded so that neurite 
segments are given the same colour as the colour of their parent neuron body. The second image 
is called the branch layer image. You can view this image by first clicking on the "Result 
Image" tab in the Result pane and clicking the "Next Image" button, which is the arrow button 
just above the result image. This image shows the neuron bodies in green, primary neurites ( 
those touching the neuron body) in yellow, secondary neurites ( those touching primary 
neurites) in pink etc. Given the fairly simple input image, we only see a few examples of 
secondary and tertiary branch layers. 

3.4.2 Table 

HCA-Vision reports a range of quantitative measures of neurite outgrowth. You can view these 
by clicking on the Table tab at the bottom of the Result pane. 

Firstly, 9 summary statistics are presented: 

 number of cells  
 total and average neurite outgrowth - the total length of all neurite structures ( in pixels) 

and this value averaged by the number of neuron bodies  
 total and average neurite area – the total area of all neurite structures (in pixels) and this 

value averaged by the number of neuron bodies 
 total and average number of segments - a segment is a linear structure between 

branching points or a neuron body  
 average branching layers and longest neurite from a cell - the average of the highest 

level of branching for a cell as shown in the branch layer image described above and the 
length ( in pixels) of the longest path from a neuron body to an extreme segment  

 total and average number of roots - the number of points where neurite structure 
touches a neuron body  

 total and average number of extreme neurites - the number of terminating neurite 
segments  

 total and average number of branch points - the number of points where a neurite 
structure splits into two or more branches  

 total length of Orphan neuritis – neurites disconnected from a cell body 

Secondly, for each neuron body we report: 

 total neurite length - sum of the length of each neurite segment  
 max neurite length - the length ( in pixels) of the longest path from a neuron body to an 

extreme segment 
 max branch layer - the highest level of branching for the cell as shown in the branch 

layer image described above  
 mean branch layer - the mean level of branching for the cell as shown in the branch 

layer image described above  
 number of branch points - the number of points where a neurite structure splits into two 

or more branches  
 number of roots - the number of points where neurite structure touches a neuron body  
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 number of segments - a segment is a linear structure between branching points or a 
neuron body  

 number of extremities - the number of terminating neurite segments  
 neurite field area - the area of the convex hull containing the cells neurite structure  
 max intensity neurite - the maximum intensity along the neurite structure  
 mean intensity neurite - the mean intensity along the neurite structure  
 integrated intensity neurite - the integrated intensity along the neurite structure  
 std dev intensity neurite - the standard deviation of the intensity along the neurite 

structure  
 branch layer statistics - for each branch layers 1 to 3, the number of branches, total 

neurite length and max neurite length are reported  
 intensity statistics - for the neuron body and each region of interest and additional 

channel (these measurements are only available when you tick corresponding options in 
Section 3.1.9 “Optional Measurement”), the maximum intensity, mean intensity, 
integrated intensity and standard deviation of intensity are reported.  

 

A diagram explaining the concept of each measure is shown in Figure 2. 

The output table can be exported as a .csv file for loading into applications like Excel by 
clicking on the "Save the Table" icon, which is a disk icon above the result table, in the Result 
pane. 

3.4.3 Cross Referencing 

HCA-Vision allows you to interactively link per cell results between result images and the 
output table. There are three ways to do this: 

If you have the input image open in the Input pane and the output table in the Result pane, you 
can click on the "row header" of a line in the output table and the corresponding cell will be 
highlighted in the input image. A "row header" is the tile at the very left of each row in the 
result table.  

If you have the input image open in the Input pane and the output table in the Result pane, press 
the "select" button (this appears as an arrow) in the row of buttons at the top of the Input pane. 
You can now click on a cell and the corresponding row will be highlighted in the output table.  

If you have the input image open in the Input pane and a result image in the Result pane, press 
the "select" button ( this appears as an arrow) in the row of buttons at the top of the Result pane. 
You can now click on a cell in the result image and the corresponding cell in the input image 
will be highlighted.  

3.4.4 Plot 

By clicking on the "Plot" tab at the bottom of the Result pane you can view a plot of each of the 
quantitative measures per cell. The Y-axis corresponds to number of neurons (Counts). The X-
axis corresponds to the measure for the neuron body, for example "Total Neurite Length". You 
can go through all the different plots by clicking the arrow icon at the top of the plot. 
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3.5 Load Parameters 

The saved profile parameters can be used later for another image similar to the one you just 
analysed. You can load a saved parameter profile at any time by clicking Action>Load All 
Parameters menu to bring up the Load All Neurite Analysis Parameters dialog box shown in 
Figure 6. Just specify the parameter profile name, then click Load button to load the parameters 
when needed. 

Figure 6 Load saved parameters 

3.6 Run Neurite Analysis Directly 

There is a toolbar (shown below) just below the menu strip. If you hover the mouse on 
individual buttons, you can see a tooltip for each button. You can simply load your saved 
parameters anytime, then click Neuron Body Detection, Neurite Detection or Neurite Analysis 
to see the corresponding results immediately. These functions can also be accessed from the 
Action Menu.  

Figure 7 Toolbar for Neurite Analysis 

3.7 Batch Processing 

HCA-Vision allows you to process multiple images as a batch. You can perform a batch process 
for either Neuron Body Detection or Neurite Analysis. The use of the batch processing 
functionality is best described via example. We will perform the Neurite Analysis on two 
images. 

Firstly, the user needs to select images for a batch. Navigate to C:\HCA-Vision\SampleImages, 
click on the black boxes next to the filenames "l1fccontrolpic7.tif" and "lifcpic5control.tif" in 
the directory viewer (left hand File pane). If your image files are all in one directory, you can 
alternatively just click on the box next to the directory name. Please note, the images to be 
processed in a batch may come from the same experiment or be similar “looking”. So when you 
tune the parameters, you just select one typical image, go through the parameter tuning wizard, 
then save the parameters. Then you are ready to process all images for the experiment by 
selecting the images you want to batch processing, then in Action menu click Batch 
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Processing>Neurite Analysis or click on the batch processing button, which is in the toolbar 
shown in Figure 7 (a directory icon with a tick inside). You will be presented with a dialogue 
box (shown in Figure 8) with the following options 

 Batch ID -  a unique label for your batch. If you do not enter a Batch ID, one will be 
automatically generated based on a time stamp for the process  

 Comments - optional notes about the batch  
 Preprocessing Option 
 Profile Name(s) -  parameter profile(s) the user has generated using the Wizards or from 

HCA-Vision's default sets. Select "lifcpic5controlr"  for each of the 3 stages.  
 Nuclei Image Suffix - during Neuron Body Detection the user can use a separate nuclei 

image to aid the detection (as opposed to a separate nuclei channel). If this is the case it 
will appear as part of the loaded parameter profile. This box allows you to enter a suffix 
that specifies the naming convention for the nuclei images in the batch. In our example, 
the parameter file associated with "Neuron Body Detection" makes no reference to a 
separate nuclear stain and hence this region is greyed out. If your image does not have 
nuclei or if the nucleus image is in a separate channel of your neurite image, ignore this 
box. This box only applies when you have separate nucleus image files for each neurite 
image to be batch processed. 

 Save Output Images - an option to save output images and specify their file type. The 
program creates a Results sub-directory in the same directory as the files you have 
selected for the batch. Within the Results sub-directory, the output image files (with 
extension .jpg) are saved.  

 Save Statistic Result in CSV file - optional to save the result statistics for each image 
into a separate exportable file for Excel etc. They are saved in the Results sub-directory 
described above. Click OK. Additionally, the results are saved to the HCA-Vision 
database by default. 
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Figure 8 Batch processing dialog box 

 

3.8 HCA-Vision Database 

Upon completing a Batch Process, the results of either the Neuron Body Detection or Neurite 
Analysis are saved into a database. From the database menu you have access to the following 
functionality: 

3.9 Database management  

We define a database as a collection of results from various batch processes. You can set the 
current database which allows you to view the results from the database's various batches or 
append further results to it. The current available databases are listed in the Set Current database 
window with the current database highlighted as shown in the following figure. 
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Figure 9 Set current database window 

The user can also create a new database if you want to save the batch processing results for your 
images into a different database by clicking Database>Database Management>Create New 
Database menu. The create new database window is shown above. 

 

Figure 10 Create new database window 

3.9.1 View batch processing results  

After running the particular analysis in batch mode, you can view its results in database format. 
For example, if you have done the batch processing described in the example in the Batch 
Processing section, select Database>View Batch Processing Results>Neurite Analysis. This 
starts up a new window with 2 tabs, shown below. 
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Figure 11 Neurite Analysis Batch processing Result display 

The default here is the "Display Results" tab. The top pane shows the images analyzed along 
with their batch ID and the image-wide summary statistics. By clicking on the line 
corresponding to an image, the cell-by-cell results are returned in the lower panes, with the 
image shown on the bottom left and the results on the bottom right. You can cross reference 
from the image to the table in much the same way as described in the results section. The batch 
processing result for the highlighted image can also be exported by clicking the Save Data 
button (the disk icon in the top pane). 

3.9.2 Query Database 

Clicking on the “Query Results” tab brings you to the functionality for database querying. To build a query, 
first “Select a Table” of results, for example “CellBasedNeuriteStatistics”. You can then “Select Fields of 
Interest” such as “Image Name”, “CellNo”, “TotalNeuriteLength” and “NumBranchPoints” by holding down 
the Ctrl button while clicking on the appropriate field. You can now "Select a BatchID" for a particular 
batch, or select all batches (by not selecting any batches, you will query all the batches). Now to build a 
query, click on the "Where" button to bring up the Where Clause window shown in Figure 12, choose a 
field, a condition and a value, for example “TotalNeuriteLength” greater than 1000, then click “Add to 
Where Clause”. If you wish to add additional queries, you must select either the “And” or “Or” operators as 
the way to combine the queries before clicking “Add to Where Clause”. Continue adding queries in this 
fashion and then press “OK”. Now press “Create Query Statement”. The statement will appear in the “SQL 
Statement Box”. Finally, press “Execute” and the results will appear in the Query Result pane as shown in 
Figure 13. The selected results can be exported to Excel etc. using the Export icon (a disk icon above the 
query result). When finished querying the data, kill the Batch Processing Results window by clicking the 
Close button (the cross in the top right corner). 
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Figure 12 Where Clause window 

 

3.10 Neurite Analysis with Mixed Cell Populations 

In mixed cell populations, it is often necessary to filter and separate each cell type before cell 
counting and further analysis. For example, Figures 14 and 15 both contain a mixture of 

Figure 13 Database query window 



NEURITE ANALYSIS 

22    Bio Image Analysis Workshop 

neurons and other brain cell types. Neurite analysis was to be performed only on neurons. In 
Figure 14, the neurons (red) can be readily separated from the astrocytes (green) and other 
unstained glial cells based on high intensity in the red channel. In Figure 15 however, the non-
neuron nuclei could only be filtered out by using a combination of their size, brightness and low 
intensity in the neuron (green) channel. 

 

 

 

  

 

 

 

 

Figure 14 To screen for compounds which drive differentiation of mouse neural stem cells into neurons, 
filter the raw image (top left) containing neurons in red and astrocytes in green, to select just the neurons 

(bottom left). Nuclei of all cell types are shown in blue. Top right and bottom right images show the neuron 
body detection and neurite analysis results, respectively. 

 

Figure 15 left – raw image with all nuclei labelled in blue (Hoechst), neurites in green (Tuj1) and synapses 
in red (Synaptophysin); middle – detected neuron bodies overlaid on the neurite channel, with non-neuron 

nuclei filtered out; right – neurite analysis result showing different levels of branching for neurons only. 

The filtering by nucleus size can be done by specifying the nucleus area in the Neuron Body 
Detection wizard page shown below: 
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Figure 16 Nucleus filtering using area criterion 

Figure 17 Nucleus filtering using intensity criteria in different channels 
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4. SUBCELLULAR ANALYSIS 

Switch to the Subcellular Module by clicking Modules>Subcellular Analysis. 

The Subcellular Analysis module allows measuring the translocation of proteins between 
virtually any two cell compartments. The functions include creating a mask or a region of 
interest, then applying the mask to capture different kinds of information or to measure 
intensities in different channels and regions. 

This module includes Nucleus Detection, Cell Body Detection, Membrane Detection, Cell 
Scoring, Colocalisation Analysis. 

4.1 Nucleus Detection 

It should be noted that if a nucleus image is available, it will be used as a mask to detect cell 
bodies. So if this is the case, please run the Nucleus Detection function before running the Cell 
Body Detection function. However, if you do not have nucleus image and you still want to 
detect cells, this can be done by just running the Cell Body Detection function.  

4.2 Cell Body Detection 

The Cell Body Detection function is almost identical to the Neuron Body Detection Function in 
the Neurite Analysis Module, except that it is made generic for any type of cell instead of just 
neurons. 

4.3 Cell Scoring 

Before running the Cell Scoring function, Cell Body Detection needs to be run to get the cell 
body masks to be used for Cell Scoring. 

This section describes how to do a multi-channel cell analysis using this option in the Wizard 
pull-down menu. This analysis is best explained by the example below. 

4.3.1 Cell Body Detection 

Choose the file "Colocalisation.tif" from the SampleImages directory in the installation if it is 
not loaded. This image is the default for this module. We would like to do some intensity 
measurements to determine the number of positive cells with respect to the green and red 
channels. Firstly we need to detect the cells. Simply click on the Cell Body Detection button in 
the tool bar (hover your mouse on the double cell icon in the toolbar, you will see the tooltip 
“Cell Detection”), or go through the wizard to produce the cell body detection result.  

4.3.2 Cell Scoring  

From the Wizard menu, select Cell Scoring. A dialogue box will pop up describing the steps 
involved - setting the primary intensity threshold, setting the secondary intensity threshold and 
generating the report.  A screenshot of the Cell Scoring module is shown in Figure 18 with the 
details for each step given below: 
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Figure 18 Cell Scoring screenshot 

 Setting the primary intensity threshold - choose from the four different intensity 
measures in the combo box for the primary channel. (the primary channel is specified as 
the channel used to do the cell detection, in this case the green channel).  This orders the 
table based on this measure. You can now click on a "row header" of the row 
corresponding to a threshold for a positive cell with respect to the primary channel. The 
Result pane will show which cells are now considered positive due to this threshold. 
Click Next.  

 Setting the secondary intensity threshold - choose from the four different intensity 
measures in the combo box for the secondary channel (the secondary channel is chosen 
during the cell detection above as the "Additional Intensity Channel", in this case the 
red channel). This orders the table based on this measure. You can now click on a "row 
header" of a row corresponding to a threshold for a positive cell with respect to the 
secondary channel. The Result pane will show which cells are now considered positive 
due to this threshold. Click Next.  

 Create report - click on the create report button and the results will appear in the Log 
pane of HCA-Vision. You will see the total number of cells, the number of positive 
primary channel (green) cells, the number of positive secondary channel (red) cells and 
the number of cells which are positive in both the primary and secondary channel. Click 
Finish. 
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4.4 Co-localisation Analysis 

The Co-localisation function reports both image-wide and cell-based features, such as Number 
of Cells detected, Pearson's Colocalization coefficient, overlap, Manders' coefficients (K1, K2, 
M1, M2), Costes’ co-localisation coefficient (M1/M2), cell area, perimeter, intensities in 
nucleus and reporter channels etc. 

Before you run this module, you need to run the Cell Body Detection function to get cell body 
masks. The cell body mask will be used to calculate cell based co-localisations. 

4.4.1 Cell Body Detection 

Click the Cell Detection icon in the toolbar or click the menu Action>Cell Body Detection 

4.4.2 Colocalisation Analysis 

Launch the Colocalisation wizard by clicking Wizard>Colocalisation Analysis Wizard. 

In the wizard, you need to specify the red and green channels for the colocalisation analysis. To 
Specify the Background Values for Red and Green Channels, leave both intensity values 0 
unless you know the background intensity value. In a future version, the average background 
will be calculated automatically. 

The colocalisation parameters reported in the Table of Results are displayed in  

Figure 19. For more details of these parameters, please refer to the publications listed in the 
reference section of this document. 
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Figure 19 Colocalisation Analysis result 

4.5 Membrane Detection 

The Membrane Detection module can be used to quantitatively measure protein expression and 
translocation to the cell surface. It automatically traces the cell surface based on the calculation 
of a minimum cost path around a point inside the cell. 

To launch the Membrane Detection Module, click Wizard>Membrane Detection Module. 
Please load the image “MembraneDetection.tif” in the SampleImages directory. The image is 
shown in the following figure. It shows results obtained on images of 3T3-L1 adipocytes 
retrovirally expressing a HA-GLUT4 reporter and immunostained. The Membrane Detection 
module was used to measure the relative amounts of GLUT4 on the plasma membrane under 
different conditions. 
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Figure 20 Membrane detection input image 

The most important wizard page is the Specify Membrane Centre/Guiding Points page. When 
you bring this page up, the Specify Centre Point is ticked by default. Just choose one of the cells 
shown on the screen and click the centre of the cell (anywhere inside the membrane), an 
overlaid image will be shown on the Input Image pane and also the membrane will be shown in 
the Result Image pane. If the detection result is correct, just click “Save Result” to save the 
detection result for the current membrane. If you wish to add more cells, click “Next 
Membrane” button and click the centre of another membrane to detect. If a cell’s membrane has 
not stained uniformly, the detected membrane may not be perfect as for the cell in Figure 21. 
However, you can improve it by: 

 Click Specify Guiding Points 

 Click a few guiding points in the area where the membrane was not detected correctly 
as shown in Figure 25. 

 Click “Apply Guiding Point” to update the detected membrane. You can always add 
more guiding points to improve the membrane detection results if needed. 

When sufficient guiding points are added, the membrane is detected properly as shown in 
Figure 26. Click “Save Result”.  
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Figure 21 Initial membrane detection result by clicking membrane centre point only 
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Figure 22 Overlaid image after clicking adding guiding points 
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Figure 23 Membraen detection result after adding guiding points 

 

Having defined the masks for the membranes you wish to measure, you have two options in the 
Specify Membrane Centre Point/Guiding Points page to modify those masks. You can thicken 
the membrane mask by changing the Dilate parameter. To exclude the parts of the membrane 
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which stained faintly, you can threshold the membrane mask by changing the Intensity 
Threshold parameter. When you are satisfied with the masks, click Next to display all the 
membrane masks. Click Finish. 

After you have defined the membrane masks using the Membrane Detection Wizard, the 
intensity measurement of membrane and other channel images will be displayed in the Result 
pane by clicking Table tab. The Result Image will show all membranes you selected. An 
example is shown below: 

 

Figure 24 Membrane detection result image of chosen membranes 

4.6 Region of Interest 

Whenever you load an image, you can choose to perform all subsequent operations on only a 
portion of the image, termed a “Region of Interest” (ROI), rather than the whole image. Simply 
click the Region of Interest button located above the input image, the second from right. It looks 
like an irregular ellipse. Then you will be able to draw any irregular shape, as shown in the 
following figure, by holding down the left mouse button, dragging it around the required region 
and releasing it to close the loop. 

Once you have created a region of interest, you can do nucleus detection, cell body and cell 
membrane detection, colocalisation analysis, intensity measurement etc. on that region 
following the same procedure as you do for the whole image. As the region may have a 
different intensity distribution compared to the whole image, you may need to go through 
individual wizards to tune the parameters instead of simply using the parameters previously 
tuned for the whole image. 
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Figure 25 Region of interests created using HCA-Vision ROI tool 

 

4.7 Intensity Measurement 

You can measure the intensity of each channel in an entire image by loading the image then 
clicking the Action>Intensity Measurement menu. Then you will see the intensity measurement 
result in the Table of Results pane. Intensities will be reported for all channels of the image. 

Alternatively, you can create a Region of Interest, then click Action>Intensity Measurement 
menu to measure the intensities for just that region.  

5. TOOLS 

From the Tools menu you can run the Create RGB Image function and also configure the 
default environment parameters of the HCA-Vision. 

5.1 Create a RGB Image 

If you happen to save your red, green and blue images into different files, you can combine 
them using the Create RGB Image function. Simply specify where your R, G, B images are 
stored, then specify the output image file location and name as shown below. If you just have an 
R and G channel image, you can ignore the B channel by leaving the B Channel Image File 
textbox blank. 
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Figure 26 Create RGB Image window 

5.2 Options 

You can modify some general options via Tools>Options menu. The Options window is shown 
below. Click General tab to display some default environment parameters used in HCA-Vision. 
These are described below:  

 Measurement Units: set the measurement unit to either pixels, micrometers, millimetres 
or centimetres.  

 Conversion (Unit/Pixel): set the conversion rate between pixels and your selected unit.  
 Max Number of Cells: set the maximum number of cells per image, default value is 

3000. 
 SQL Command Timeout: set the timeout for an SQL command, default value is 300 

seconds.  
 Display Accumulated Membrane Result – when ticked, membranes detected from 

different images will be displayed in the same result table for further analysis. 
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Figure 27 Option window to specify HCA-Vision global environment variables 

 

Click the Preferences tab to display the following parameters: 

 Default Nuclei Image Directory: when browsing for separate nuclei images, this is the 
default location  

 Sample Image File: default image when no images are selected  
 Regions File: a file for colour mapping output images  
 Cell Detection Parameter Files: files which store all the user and default parameter 

settings for the current analysis module: 

Neurite Analysis Subcellular Analysis 
Neuron Body Detection Nucleus Detection 
Neurite Detection Cell Detection 
Neurite Analysis Membrane Detection 

 

 Help File: the location of the help file  
 Licence Key File: licence file location  
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6. HANDS ON PRACTICE – A STEP-BY-STEP GUIDE ON 
NEURITE ANALYSIS  

In this session, we are going to reproduce the results presented in the following paper: 

Vallotton et al. Automated Analysis of Neurite Branching in Cultured Cortical Neurons Using 
HCA-Vision. Cytometry, Part A, 71A(10):889--895, October 2007. 

Sample images and tracing results reported in the paper can be downloaded from the following 
website: 

http://www.hca-vision.com/CytometryA_files/ 

Download image files in “Min” and “Pos” directories. 

Our purpose is to assess in a systematic manner the phenotype of Sez-6 null neurons (Sez-6 is a 
protein involved in brain development). 

6.1 Detecting Neuron Bodies 

 Launch HCA-Vision. 
 Set Module to “Neurite Analysis” 
 Open the image Min\mNM1.tif. This image is the first of about 50 images 

corresponding to the null mutant (the one lacking the protein). 
 Go to the menu wizard – neuron body detection wizard. As the name suggests, the 

purpose of this assistant is to segment the cell bodies (i.e. the neurons without their 
neurites). Measurements are to be obtained on a per-cell basis. 

 

 
Figure 28 The detected neuron body is shown in green 

 

 Read the outline of the different steps for detecting the neuron bodies. Press Next, and 
Next again, because you have already selected your image.  

 Press Next again, because the image features only a single channel (no color). 

http://www.hca-vision.com/CytometryA_files/
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 Gaussian filter the image using a filter width of 5 pixels. Press Next. 

 

 Remove background bias using a value for the size of the structuring element equal to 
99 pixels. Press Next. 

 Suppress neurites using a size of the structuring element equal to 10 pixels. Observe 
that the neuron body maintains its approximate shape because it is much larger than that 
threshold. In contrast neurites have mostly disappeared. Press Next. 

 Threshold the image using a normalized value equal to 0.6. Activate the flickering 
mode by clicking on white arrow on a green background (above the result image). This 
develops a set of menus. Activate overlay – enable flicker – original image. Convince 
yourself that the suggested value is reasonable. Try other settings and revert to the value 
of 0.6. Press Next. 

 Observe that you do not have a nucleus image available. Therefore, untick the 
checkbox having that name. Do not worry about the image appearance and press Next, 
and Next again. 

 Tick the Segmentation box to ensure that touching neuron bodies will be split  
 Specify a minimum neuron body area of 1600 pixels, which is just enough to suppress 

cell debris but not enough to remove genuine neuron bodies. Press Next, and Next 
again because we do not have an additional channel to measure signals from. Press 
Next. 

 Save the profile name under your own name, and Finish. 

6.2 Detecting Neurites 

 Proceed to the menu wizard – neurite detection wizard, and read the different steps. 
Press Next, and Next again, because we wish to act upon the currently selected image. 

 Press Next as there are three channels available, select channel ‘0’. Press Next. 

 

 
Figure 29 All linear features are overlaid onto the original image 
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 Filter the image using a Gaussian filter of a width equal to 7 pixels. Experiment with 
this setting. Too large a width will suppress the contrast of neurites. Too small a width 
does not improve the continuity of neurites along their length. Press Next. 

 Use a window size of 9 pixels, which is the length of the line along which the algorithm 
assesses whether a pixel represents a local intensity maximum.  

 Specify a contrast of 1.5, which (roughly) demands that the intensity of the center pixel 
along the line be at least 1.5 times the average intensity along that line. Notice how you 
can miss all neurites by specifying a very large value. Experiment with a value of 0.1. 
Revert back to a value of 1.5. Activate the flickering mode. Convince yourself that the 
suggested value is reasonable. You may want to zoom on the cell to see details. Press 
Next. 

 Remove objects smaller than 10 pixels in diameter. Press Next. 
 Close gaps of a maximum span of 9 pixels and demand that the quality of the bridging 

path be at least 30%. Press Next. 
 Save the profile under your name and finish. Observe that the cell body boundaries are 

detected as linear features by mistake. This should not worry you because the neuron 
body masks will be covering these linear features. 

6.3 Analysing Neurites on a Per Cell Basis 

 Start the neurite analysis wizard. The purpose of this wizard is to combine results 
obtained in the neuron body detection wizard with those of the neurite detection 
wizard. Read the different steps and press Next, and Next again. 

 Debarbing is the process of removing small lateral branches from the neurite traces 
that may have been created as a result of noise in the image. Select a length threshold of 
11 pixels. Press Next. 

 
Figure 30 The neuron body is shown in green. Primary neurites are traced in yellow, and secondary 
neurites are in purple. The neurite analysis wizard relies on the parameters of both the neuron body 

wizard, and the neurite tracing wizard to produce these results. 

 Thicken the neuron body by 4 pixels. This will ensure that neurites are connected to 
their respective neuron bodies, and therefore not removed from the analysis. 

 Remove trees smaller than 8 pixels. Activate again the flickering mode and convince 
yourself that you’ve done a decent job of analyzing this image. 
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 Save the profile under your name and finish the wizard.  

6.4 Batch Processing 

 Select another image of the sequence, such as mNM10.tif and directly click on the icon 
corresponding to neurite analysis, which is the one representing a man with a 
magnifying glass in the toolbar. Evaluate the quality of the results using the flickering 
mode and the zoom.  

 Do the same with a few images randomly selected in the same directory. This is the 
stage whereby, if you find that one particular image is analyzed sub-optimally, you 
need to modify the analysis parameter without affecting the quality of the results 
obtained on the other images. This may be relatively time consuming for a dedicated 
user.  

 Use the batch processing capabilities to analyze all images in the directory. To that 
effect, in the directory tree check the box next the “Min” directory and click on the 
batch processing icon in the toolbar, selecting neurite analysis, and specifying your 
newly created parameter profiles if needed. Launch the batch analysis using the OK 
button and be patient… 

 Let us examine the results by launching the menu database – view batch processing 
results – neurite analysis. 

 Observe that each batch run is characterized by its own batch ID, in order to avoid 
mixing results from one experiment with those of another experiment.  

 The averaged results in the top table are not always useful because the information 
should be analyzed on a per-cell basis, rather than on a per image basis. The table on the 
right of the result image contains information for every cell. Click at the very beginning 
of one row to highlight in the result image the cell for which that row pertains. Copy-
paste the various statistics for cells that are entirely in the image and that do not touch 
other cells in ExcelTM.  

 Now, using the same parameter profiles, repeat the batch processing for the dataset in 
the directory “Pos” (corresponding to the wild type cells) and assess whether the 
phenotypic statistics are significantly different for the wild type cells compared to the 
Sez-6 null cells.  

6.5 Database Query 

 
Using the query results function of the database window, isolate all cells that possess more 
than 3 roots segments, and that feature a neuron body area over 2000 pixels. Measure the 
average neurite field for only these cells.  
 



HANDS ON PRACTICE – A STEP-BY-STEP GUIDE ON NEURITE ANALYSIS 

40    Bio Image Analysis Workshop 

ACKNOWLEDGEMENT  

We would like to thank the following people for allowing us to use their images in 
HCA-Vision: 

 

Prof. Pat Doherty, Kings College, London, UK. 

Dr. Myles Fennell, Wyeth Research, Princeton, NJ, USA.  

Dr. Jenny Gunnersen, Howard Florey Institute, University of Melbourne, Australia. 

Dr. Stephen Haggarty, Broad Institute of Harvard and MIT, USA. 

Dr. Jamie Lopez, Garvan Institute, Australia. 

Prof. Phillip Nagley, Monash University, Australia. 

Dr. Brent Reynolds, Queensland Brain Institute, Australia. 

Ms. Michelle Thacker, University of Melbourne, Australia. 

Dr. Xiaokui Zhang, Helicon Therapeutics, Inc., USA. 

 

REFERENCES  

1) D. Wang, R. Lagerstrom, C. Sun, L. Bischof, P. Vallotton, and M. Götte. HCA-Vision: 
Automated Neurite Outgrowth Analysis. Journal of Biomolecular Screening, 
15(9):1165--1170, October 2010. 

2) Costes, S. V., D. Daelemans, E. H. Cho, Z. Dobbin, G. Pavlakis, and S. Lockett. 
Automatic and Quantitative Measurement of Protein-Protein Colocalization in Lives 
Cells, Biphysical Journal. J.86:3993-4003, 2004. 

3) Manders, E. M. M., Verbeek, F. J., and Aten, J. A.,  F, Measurement of Co-Localisation 
of Objects in Dual-Color Confocal Images, Journal of Microscopy, Vol. 169, Pt 3, pp. 
375 – 382, March 1993. 

4) HCA-Vision website: www.hca-vision.com 

 

http://www.hca-vision.com




 

 

 

 


